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Notice

The material contained in this manual, and in the online help for the software used to support this instru-
ment, is believed adequate for the intended use of the instrument. If the instrument or procedures are used 
for purposes other than those specified herein, confirmation of their suitability must be obtained from TA 
Instruments. Otherwise, TA Instruments does not guarantee any results and assumes no obligation or liabil-
ity. TA Instruments also reserves the right to revise this document and to make changes without notice.

TA Instruments may have patents, patent applications, trademarks, copyrights, or other intellectual prop-
erty covering subject matter in this document. Except as expressly provided in written license agreement 
from TA Instruments, the furnishing of this document does not give you any license to these patents, trade-
marks, copyrights, or other intellectual property.

TA Instruments Operating Software, as well as Module, Data Analysis, and Utility Software and their asso-
ciated manuals and online help, are proprietary and copyrighted by TA Instruments. Purchasers are granted 
a license to use these software programs on the module and controller with which they were purchased. 
These programs may not be duplicated by the purchaser without the prior written consent of TA Instru-
ments. Each licensed program shall remain the exclusive property of TA Instruments, and no rights or 
licenses are granted to the purchaser other than as specified above.

TA Instruments can accept no liability for loss or damage, however caused, arising from the faulty or 
incorrect use of its products.TA Instruments shall not be liable for any damages caused by interactions 
between exogenous materials (e.g. chemicals) and parts of the instrument. This includes interactions of 
gaseous, liquid or solid materials with, for instance, ampoule surfaces and/or parts of the instrument. It also 
includes gases or vapors leaking from ampoules (e.g. originating from chemical reactions 
producing gaseous substances), with subsequent cause of damage to the calorimeter.

©2013-2017 by 
TA Instruments — Waters LLC 
159 Lukens Drive
New Castle, DE 19720
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Introduction

Important: TA Instruments Manual Supplement

Please click the TA Manual Supplement link to access the following important information 
supplemental to this Getting Started Guide:

• TA Instruments Trademarks 

• TA Instruments Patents 

• Other Trademarks 

• TA Instruments End-User License Agreement 

• TA Instruments Offices 
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Notes, Cautions, and Warnings

                                                   
This manual uses NOTES, CAUTIONS, and WARNINGS to emphasize important and critical 
instructions. In the body of the manual these may be found in the shaded box on the outside of the page.

NOTE: A NOTE highlights important information about equipment or procedures.

CAUTION: A CAUTION emphasizes a procedure that may damage equipment or cause loss of data 
if not followed correctly.

MISE EN GARDE: UNE MISE EN GARDE met l'accent sur une procédure susceptible d'endom-
mager l'équipement ou de causer la perte des données si elle n'est pas correctement suivie.

Regulatory Compliance

Safety Standards

EMC Directive

This instrument has been tested to meet the European Electromagnetic Compatibility Directive (EMC 
Directive, 2014/30/EU). The Declaration of Conformity for your instrument lists the specific standards to 
which the unit was tested.

The instrument was designed specifically as a test and measuring device. Compliance to the EMC directive 
is through IEC 61326-1 Electrical equipment for measurement, control and laboratory use - EMC require-
ments (1998).

As noted in the IEC 61326-1, the instrument can have varying configurations. Emissions may, in non-typi-
cal applications, exceed the levels required by the standard. It is not practical to test all configurations, as 
the manufacturer has no control over the user application of the instrument.

Immunity Testing

The instrument was tested to the requirements for laboratory locations.

Emission Testing

The instrument fulfills the limit requirements for Class A equipment but does not fulfill the limit 
requirements for Class B equipment. The instrument was not designated to be used in domestic 
establishments.

A WARNING indicates a procedure that may be hazardous to the operator or to the environment 
if not followed correctly.

Un AVERTISSEMENT indique une procédure qui peut être dangereuse pour l'opérateur ou 
l'environnement si elle n'est pas correctement suivie.
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Low Voltage Directive (Safety)

In order to comply with the European Low Voltage Directive (2014/35/EU), this equipment has been 
designed to meet IEC 1010-1 (EN 61010-1) standards. To comply with requirements in the USA, this 
instrument has been tested to the requirements of UL61010a-1.

Safety

Electrical Safety

There are no user-serviceable parts inside the instrument; voltages as high as 125/250 VAC are present in 
this system.

Lifting the Instrument

The Nano DSC is not a portable instrument. In order to avoid injury, particularly to the back, please follow 
this advice:

 

WARNING: Use appropriate care when unpacking or moving the instrument. It may be too 
heavy for some individuals working alone to handle safely.

AVERTISSEMENT: Soyez prudent lors du dépotage ou du déplacement de l'instrument. Il peut 
être trop lourd à manipuler en tout sécurité pour des personnes travaillant seules.

DANGER: High voltages are present in this instrument. Maintenance and repair of internal parts 
must be performed only by TA Instruments or other qualified service personnel.

DANGER: Présence de tensions élevées dans cet instrument. La maintenance et la réparation 
des pièces internes doivent être effectuées uniquement par TA Instruments ou tout autre per-
sonnel d'entretien qualifié.
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Chapter: 1
Introducing the Nano DSC

Overview
The TA Instruments Nano Differential Scanning Calorimeter (Nano DSC) is designed specifically for the 
measurement of absolute heat capacities of biopolymers in dilute solution. 

 Figure 1 The Nano DSC instrument.

The Nano DSC offers improvement in sensitivity and baseline repeatability. The instrument is a power 
compensation design using a completely solid-state thermostat and is equipped with fixed continuous plat-
inum capillary or 24K gold cylindrical cells.

With an operating temperature range of –10 to 130°C (or 160°C for high-temperature units), scan rates up 
to 2°C/min in both the heating and cooling directions, and baseline repeatability of ±0.4 µcal/C @ 
1°C/min. The Nano DSC can be used to study the thermal denaturation of many proteins with as little as 
52 µg or less of sample.

Instrument Models Covered in this Guide

Models 602000 and 602001

Spill plate

Pressure handle
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Applications

The Nano DSC allows you to study almost any thermal transition occurring in dilute biopolymer solution 
in the temperature range of –10 to 130°C. It also offers a new dimension in sensitivity, baseline noise, and 
baseline repeatability in both heating and cooling modes.

The measurement of absolute heat capacities using the instrument enables the examination of biopolymer 
solution conformation and solvation, as well as subtle changes in folding.

Studies of biopolymer thermal stability and the effects of biopolymer or ligand interactions on macromo-
lecular structure can be accomplished with the Nano DSC. The baseline repeatability ensures that reliable 
DCp data can be obtained from a single scan.

Typical uses for the Nano DSC include:

• Biopolymer solution conformation and solvation (absolute heat capacities)

• Biopolymer stability (protein denaturation)

• Biopolymer structure (domain organization)

• Bioengineering (mutant proteins)

• Ligand interactions (drug binding to proteins or nucleic acids)

• Membrane structure (lipid bilayers, membrane proteins)

• Polynucleotides (helix to coil transitions)



Nano DSC Getting Started Guide Page 10

System Components
The following items make up a Nano DSC system:

• Nano Differential Scanning Calorimeter

• Power cord

• Computer system (optionally available from TA Instruments) and display monitor with accessories, 
and all required software with online Help and manual. The computer system is current technology at 
the time of purchase, and uses the Microsoft Windows operating system.

• Pressure handle and 1 replacement o-ring.

• 1-mL filling syringe and filling needles (cylindrical cell instrument only)

•  Cell cleaning adapter with silicone tubing (cylindrical cell instrument only)

• 2.5-mL micropipette with tips and silicone tubing (capillary cell instrument only)

• Silicone tubing for cleaning (capillary cell instrument only)

• Windows-based Experiment Setup, Data Collection and Analysis Software (This software was previ-
ously installed at the factory and the supplied disk is typically used for software reinstallation.)

Options and Accessories

The following items are available to complement your Nano DSC instrument:

• Vacuum Degassing System

• Personal computer with Microsoft Windows Operating System

• Additional filling needles

• Replacement 1-mL syringe

• Micropipetter and micropipette tips

• Replacement Nano DSC cleaning adapter

• Replacement silicone tubing for cleaning adapter

• Replacement pressure handle

• Replacement pressure o-ring kit
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Instrument Specifications
The table found below contains the technical specifications for the Nano DSC instrument.

Table 1: Nano DSC Technical Specifications   

Item/Area Specifications

Dimensions Depth 53 cm (21 in.)
Width 35 cm (14 in.)
Height 28 cm (11 in.)

Weight 17 kg (37 lbs)

Power 100–240 VAC, 3 amps. 50 or 60 Hz 

Electrical power cord The plug of the cord must be rated to carry at least 125% of 
the product current rating. The cord length must be less than 
4.5 meters and must be UL or CSA approved.

Operating environmental conditions Temperature: 15°C to 30°C
Relative humidity: 5 to 80% (non-condensing)
Installation category II
Pollution degree 2
Maximum altitude: 2000 m (6560 ft)

Emissions class Class A

Temperature range –10 to 130°C (Standard Temperature) or
–10 to 160°C (High Temperature)

Temperature scan rate 0°C to 2°C/min

Response time Halftime = 5 s

Baseline repeatability 0.028 µW

Baseline noise Standard deviation 0.015 µW

Cell construction Capillary in platinum or cylindrical in 24K gold 

Cell volume 0.30 mL nominal capillary or 0.33 mL cylindrical 

Cell pressurization range 0 to 6 atm
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Chapter: 2
Installing the Nano DSC

Unpacking/Repacking the Nano DSC

CAUTION: To avoid mistakes, read this entire chapter before you begin installation.

MISE EN GARDE: Pour éviter de commettre des erreurs, lisez tout le chapitre avant de commencer 
l'installation.

The instructions needed to unpack and repack the instrument are found as separate unpacking instructions 
in the shipping box. You may wish to retain all of the shipping hardware and boxes from the instrument in 
the event you wish to repack and ship your instrument.

Installing the Instrument
Before shipment, the instrument is inspected both electrically and mechanically so that it is ready for oper-
ation upon proper installation. Only limited instructions are given in this manual; consult the online 
documentation for additional information. Installation involves the following procedures:

• Inspecting the system for shipping damage and missing parts

• Connecting the Nano DSC to the computer

• Connecting USB cables

It is recommended that you have your Nano DSC installed by a TA Instruments Service Representative; 
call for an installation appointment when you receive your instrument.

Inspecting the System

When you receive your instrument, look over the instrument and shipping container carefully for signs of 
shipping damage, and check the parts received against the enclosed shipping list.

• If the instrument is damaged, notify the carrier and TA Instruments immediately.

• If the instrument is intact but parts are missing, contact TA Instruments.

WARNING: Have an assistant help you unpack this unit. Do not attempt to do this alone.

AVERTISSEMENT: Faites-vous aider par une personne pour dépoter cet appareil. N'essayez 
pas de le faire tout seul.
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Choosing a Location
It is important to choose a location for the instrument using the following guidelines. The Nano DSC 
should be:

In

• a temperature- and humidity-controlled area. Temperatures should be in range 15 to 30°C.

• a clean, vibration-free environment, preferably on the ground floor in the building. It should be located 
away from pumps, motors, or other devices which produce vibrations.

• an area with ample working and ventilation space. At least 18 by 18 inches is needed for the instru-
ment. Additional space is needed for the computer and (if present) printer. 

On

• a stable work surface. 

Near

• a power outlet. See the “Power Requirements”  section below.

• your computer.

Away from

• dusty environments.

• exposure to direct sunlight.

• direct air drafts (fans, room air ducts). 

• poorly ventilated areas. 

• noisy or mechanical vibrations.

• high traffic areas, where constant movements from passing personnel could create air currents or 
mechanical disturbances.

Power Requirements 

The Nano DSC requires a grounded, single-phase power source. A three-conductor line cord ensures a 
safety ground. The operating voltage and line frequency were preset at the factory for 100–240 VAC, 
50 or 60 Hz operation. 

It is highly recommended that the instrument and computer system should be operated from a single power 
source. Use a power distribution strip with a surge suppressor function. If the local power mains experi-
ence fluctuating voltage or surge conditions, it is also advisable to use a power conditioning uninterrupt-
able power supply (UPS).

The instrument requires one (1) 15-A line for the instrument and computer system. Attach all items to a 
single surge suppressor plug strip. Plug the surge suppressor strip into an isolated power line. An isolated 
power line is one that is used only for electronic instruments (i.e., no inductive motors, compressors, or 
heaters) that do not create power surges upon start-up.

Attach the instrument and all computer accessories to the surge suppressor. 



Nano DSC Getting Started Guide Page 14

Gas Requirements

Because the Nano DSC is capable of running below room temperature, the calorimeter’s thermal shield 
features a sealed environment that has been filled with dry nitrogen gas. 

CAUTION: The purge port valve on the back of the Nano DSC should remain in the closed position 
at all times to maintain the integrity of the nitrogen purge.

MISE EN GARDE: La vanne de l'orifice de drainage située à l'arrière du Nano DSC [ITC] doit tou-
jours rester en position fermée pour maintenir l'intégrité de l'azote drainé.

NOTE: Purging of the canister is not a routine maintenance operation; contact TA Instruments for service 
if the Nano DSC exhibits unstable baselines especially above 50 or 60°C.

Electrical Connections

1 Make sure all of the equipment is turned off.

2 Make sure the power switch to the surge suppressor is in the OFF position.

3 Plug the power cord into the Nano DSC and the surge suppressor strip.

4 Assemble the computer system per the instructions included in its shipment carton. 

5 Install DSCRun software, following the instructions in the “Installing DSC Run” document found on 
the TA Instruments software CD.

6 Connect the calorimeter to the computer system with the supplied USB cable.

7 Ensure that airflow to the cooling fan on the rear panel of the calorimeter is not blocked by bench 
back-splashes, walls, or other equipment.
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Starting the Nano DSC
Once you have completely set up the calorimeter and computer system, start the instrument as follows:

1 Turn on the surge suppressor power switch and the computer system and monitor. Allow the computer 
to boot up.

2 Turn on the power switch to the calorimeter, which is located on the back panel. The front LED will 
light up when in the “on” position. 

 Figure 2 Power LED on Nano DSC instrument.

3 Start DSCRun™ software on the computer (see the figure below). Instrument control and regulation is 
supplied by the software. Initial thermal stabilization may take an hour or longer.

 Figure 3 DSCRun software screen.
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Shutting Down the Nano DSC
You can leave the instrument and its associated components on when the Nano DSC will be inactive for 
two to five days. 

If the Nano DSC will be inactive for more than five days, TA Instruments recommends that you turn all 
equipment off. 
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Chapter: 3
Use, Maintenance, & Diagnostics

Overview
A typical Nano DSC experiment involves the following:

• Preparing the buffer/solvent and biopolymer solutions

• Running the baseline and the sample solution scans

• Cleaning the calorimeter

• Performing a thermodynamic analysis

Each step is briefly described below. Additional information is provided in the online Help supplied with 
the software program. It is assumed that you are familiar with standard laboratory procedures and tech-
niques. It is critical that the Nano DSC cells be cleaned immediately at the end of each experiment. 
Although the calorimeter can be left idle with water-filled cells at 25°C when not performing experiments, 
it will generally perform better when it is left continuously scanning. This is done by filling the cells with 
deionized degassed water, pressurizing the cell to 45 psi (3 atm), and scanning up and down continuously 
between the upper and lower temperature limits at 1°C/min.

Preparing the Buffer Solutions 

The solvent systems used for preparation of dilute biopolymer solutions are typically buffered aqueous 
solutions, which often contain supporting strong electrolytes (for example, NaCl or KCl) to adjust the ionic 
strength. To prepare a buffer, follow these steps:

1 Weigh an appropriate amount of the acidic or basic form of a weak acid (or weak base) into a measured 
volume of distilled or deionized water. 

2 Adjust the pH of the buffer to the desired value by adding either strong acid (for example, HCl) or strong 
base (for example, NaOH), while monitoring the buffer pH using a pH electrode and meter. The buffer 
will provide the calorimeter baseline. It will also be used to prepare and dialyze the protein (or nucleic 
acid) solution.

3 Prepare a rather large volume of the buffer (for example, 1 L). It should be noted that buffers used in 
DSC experiments should be carefully chosen to meet the following criteria: 

• The pKa should be as independent as possible of the temperature. 

• The ΔH for proton ionization from the buffer acid should be small. 

• All components of the buffer/solvent solution should be thermally stable. (The buffer should not 
precipitate or change color on boiling.)
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Preparing Dilute Biopolymer Solutions 

Choose the concentration of the biopolymer to allow optimization of the amount of thermodynamic infor-
mation. In the case of a typical protein, good heat capacity data can usually be measured for solutions with 
protein concentrations in the 0.2 to 5 mg/mL range. When possible, obtain the information regarding the 
optimum concentration and solution conditions for DSC studies of specific biopolymers from the litera-
ture. 

The minimum of volume of dilute protein solution required to fill the Nano DSC cylindrical cell is 0.5 mL. 
About 0.65 mL is required to fill a capillary cell. A protein solution is normally be prepared by weight or 
by dilution of a concentrated stock solution. For the best results, dialyze the protein (or other biopolymer 
sample) before your DSC experiment. Then use the dialysate for the reference solution. 

It must be noted that high sensitivity DSC studies should be done with highly purified biopolymers. 
Accepted techniques should be used for sample purification prior to solution preparation and dialysis. It is 
critical to know the solute (biopolymer) molecular weight, concentration and state of oligomerization prior 
to attempting a thermodynamic analysis of the heat capacity data.

Degassing the Buffer and Sample Solutions 

Typically, if a solution is heated, gas bubbles will form as the solubility of dissolved gases (such as O2 and 
N2) is decreased with increasing temperature. If gas bubble formation occurs in the DSC cells during the 
run, the resulting heat capacity data will be rather noisy since abrupt changes in the apparent heat capacity 
will result from the bubble driven liquid displacement effects. 

All reference and sample solutions must be degassed prior to being placed in the DSC to minimize the pos-
sibility of gas bubble formation during the run. Pull a vacuum of 15 to 25 inches Hg on the solutions for a 
period of 10 to 15 min to degas a sample. An accessory degassing station is available from TA Instruments. 

Gas bubble formation during the run is retarded by the cell pressure (up to 3 to 6 atm) provided by the DSC 
manostat. However, it is still necessary to remove the atmospheric gasses from the solutions.
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Running Baseline and Sample Solution Scans
The second major step in an experiment includes running the baseline and sample scans. The first step in 
this procedure is to fill the cells. There are two protocols for filling the cells, depending on the type of 
Nano DSC cell design. Cylindrical cells utilize a syringe while capillary cells use a pipette. Follow the 
instructions that relate to your particular type of cell.

Selecting Solutions

Follow these guidelines when choosing the solution to use in your experiments:

• Baseline Run: Fill both the sample cell and reference cells with the same solution (buffer dialysate). 

• Sample Run: Fill the sample cell with the dialyzed protein (or other biopolymer) solution and the 
reference cell with the dialysate.

Filling Cylindrical Cells

Filling the cell is one of the most important parts of conducting a DSC experiment and should be done with 
extreme care. The objective is to fill the cell with the appropriate solution without introducing any air bub-
bles. Even the smallest bubble can result in heat capacity data that is erratic and offset. You will need a 
1-mL Hamilton syringe equipped with a 20-gauge needle (this needle and syringe are supplied with your 
instrument). 

NOTE: Proteins in solution have a tendency to foam when manipulated with a pipette.

1 Make sure that the cells are empty. Starting with the reference cell (left-most access tube as viewed from 
the front of the DSC), begin by filling the syringe with approximately 0.5 mL of solution. You may find 
that larger volumes make the procedure easier, but it is possible to load the cell correctly with the lesser 
amount. Be careful not to trap any air bubbles.

2  Insert the syringe into the reference cell and load the calorimeter in the following manner ():

a Position the needle so that it lightly touches the bottom of the reference cell (left access tube) initially. 
See the figure below.

 Figure 4 Inserting the syringe.
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b Raise the syringe off the bottom approximately 1/16 in.

c Gently inject the solution into the cell until you see it coming out of the access tube.

3 Slowly pump about 0.1 mL of solution in and out of the access tube and watch to see if bubbles are 
coming out of the access tube. Perform this operation a number of times until it is apparent that there 
are no bubbles in the cell. 

4 Slowly withdraw the needle from the access tube while simultaneously injecting solution to clear away 
any bubbles trapped by the needle.

5 When you are finished, the reservoir located at the top of the access tube should be filled up to halfway 
with solution.

6 Repeat the entire process to fill the sample cell (right access tube). In the case of a baseline run, the 
sample cell will be filled with the same solution (buffer dialysate) that was placed in the reference cell. 
In the case of the sample run, the sample cell will be filled with the dialyzed protein (or other biopolymer) 
solution.

Filling the Capillary Cells

Equipment Required:

• Adjustable 500 to 2500 µL pipette (Eppendorf Series 2000 supplied)

• Tubing (1/16-in. ID Manosil silicone rubber)

NOTE: Additional care must be taken with proteins and other biopolymers since they have a tendency to 
foam when manipulated with a syringe.

As with a cylindrical cell, filling the capillary cell is one of the most important parts of conducting a DSC 
experiment and should be done with extreme care. The objective is to fill the cell with the appropriate solu-
tion without introducing any air bubbles. Even the smallest bubble can result in heat capacity data that is 
erratic and offset. You will need an adjustable volume pipette with the volume set between 800 and 
1000 µL. (With experience, this volume can be reduced to 0.65 mL). 

You will also need four clean pipette tips and four short lengths (approximately 0.5 in) of 1/16 in. I.D. 
Manosil silicone rubber tubing.

1 Be sure that the samples have been properly degassed. See “Degassing the Buffer and Sample Solutions” 
on page 18.

2 Displace any residual liquid from the cells by blowing them out with an inert gas (N2) at low pressure.
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3 Prepare the pipette tips, used with the micropipette for loading and cleaning the DSC cells. Fit the 
disposable plastic tips with a short (approximate 0.5-in. long) length of Manosil silicone tubing to 
interface with the cell access tubes. The figures below illustrate how to trim and prepare the pipette tips. 
A length of the appropriate silicone tubing is provided with each calorimeter. Additional tubing can be 
ordered through your laboratory supplier or TA Instruments.

 Figure 5 Cutting the silicon tubing on the pipette tip (top image); completed pipette tip (bottom image).

4 For best bubble-free filling, leave the cells full of water while the instrument is idle. Empty the cells 
immediately before refilling. Aspirate by hand with a syringe, or with a vacuum pump just long enough 
to remove the liquid (about 2 seconds). This promotes wetting by preventing the cell surface from 
becoming completely dry. 

Aspirate by hand with a syringe or with a vacuum pump just long enough to remove the liquid (about 2 
seconds). This promotes wetting by preventing the cell surface from becoming completely dry. 

5 Start with the reference cell (left-most pair of access tubes as viewed from the front of the DSC). Attach 
one pipette tip to either the front or rear access tube.

6 Attach the second pipette tip to the pipette and fill it with at least 650 µL of the reference solution (buffer 
dialysate). 
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7 Attach the silicone extension of the pipette tip to the reference cell’s inlet access tube. See the below. 
Fill the cell slowly (over 5 to 10 seconds) by gently depressing the pipette plunger.

 Figure 6 Pipette and silicone tubing attachment to reference cell access tubes.

8 Pipette and silicone tubing attachment to reference cell access tubes.

9 Completely fill the cell until you see solution emerge from the outlet access tube into the empty pipette tip.

10 Hold the outlet pipette tip vertically and make a few short strokes with the pipette plunger to gently force 
solution back and forth through the capillary cell. Be careful not to introduce air bubbles into the cell 
by letting either pipette tip go dry. This technique helps to get rid of any bubbles that might still be 
trapped in the capillary channel.

11 Make sure the reference cell is free of bubbles then remove the pipette tips and pipette from the inlet 
and outlet access tubes. Minimize solution spillage by covering the open end of the free pipette tip with 
your thumb while removing it from the access tube.

12 Repeat the entire process to fill the sample cell (right-most pair of access tubes).

13 Cap one of the access tubes with the small black access tube cap (see the figure below). Leave one access 
tube open on each cell to allow pressurization.

 Figure 7 Cap placement on rear access tubes.

14 Remove excess liquid from the surrounding area outside of the access tubes using suction or a lab tissue.
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Cell Pressurization and Checking for Bubbles

The last steps needed when loading the cells are to attach the pressure handle to the access flange, 
pressurize the cell and check for bubbles. Follow these steps, in order:

1  Screw the threaded ring on the pressure handle onto the access flange tightly, as shown in Figure 8.

 Figure 8 Attaching the pressure handle.

CAUTION: Do not pressurize the cells at this time.

MISE EN GARDE: Ne mettez pas les cellules sous pression à cet instant.

2  Make sure the Nano DSC is powered on.

3  Open the DSCRun™ program by double clicking the DSCRun icon located on the Windows desktop 
(if it is not already running). 

4 Wait for the baseline to stabilize within a few tenths of a microwatt before beginning an experiment. 
Equilibration is complete when the µW reading (as displayed in the Output box shown in the figure 
below) settles to constant value.

 Figure 9 
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5 Set the manostat pressure to a value of at least 3 atm (up to 6 atm for high-temperature instruments) 
using Tools > Runtime variables.

6 Increase the pressure by clicking on the up arrow in the DSCRun program (see the figure below) while 
monitoring the manostat pressure as displayed on the computer monitor.

• If a bubble is present, the µW reading will exhibit a significant momentary change (in excess of 
30 µW) as the pressure is increased from 0 to 3 atm. 

• If bubbles are indicated by an unstable µW reading as the cell pressure is applied, the cells must be 
refilled using the procedures outlined previously. 

• If you see little or no effect, proceed to the next step.

7 Set the experiment parameters and start the scans. See the online Help for more information.

An important final step in any experiment is cleaning the calorimeter. The Nano DSC is an extremely 
sensitive instrument that will perform well only if kept scrupulously clean. See the next section for 
information.



Nano DSC Getting Started Guide Page 25

Cleaning the Nano DSC
Immediately after every experiment sequence (that is, after the baseline and sample scans are both com-
pleted for a specific experiment) the Nano DSC cells should be washed. 

CAUTION: The pressure handle should not be attached to the calorimeter during cleaning.

MISE EN GARDE: Le manche à pression ne doit pas être fixé au calorimètre pendant le nettoyage.

NOTE: Do not clean the cells between the buffer/buffer and the buffer/sample scans). 

The general procedure for cleaning the DSC cells with formic acid is described below.

The following cleaning process is suitable for most samples (more vigorous cleaning is accomplished by 
following the procedures described later in this chapter):

1 Wait until the calorimeter is idling at approximately 20 to 30°C, then reduce the cell pressure to zero. 

2  Click down arrow and remove the pressure handle from the access flange when depressurization is 
complete. 

3 Empty the cells as follows:

• If you have a cylindrical cell, use the 1- mL syringe to remove the solutions from the cells. 

• If you have a capillary design, remove the cell outlet tube caps first and then empty the cells with 
the pipette or vacuum pump.

CAUTION: Ensure that the small black caps (capillary cell) and the pressure handle have 
been removed.

MISE EN GARDE: Assurez-vous de retirer les petits bouchons noirs (cellule capillaire) et le 
manche à pression.

4 Fill the cells with the recommended cleaning solution (50% formic acid), then run one scan cycle from 
25 to 80°C at 1°C per minute. Do not install the pressure handle.

5 When the temperature has returned to approximately 25°C, aspirate and discard the cleaning 
solution. Thoroughly rinse all areas that come into contact with corrosive chemicals. Do not let 
any solutions pool inside the access tube area. 

6 Rinse the cells with a generous volume of high quality deionized water using the appropriate equipment 
for your cell design. See the next two sections and follow the flushing directions for your instrument.

CAUTION: Thoroughly rinse all areas that come into contact with corrosive chemicals. DO NOT let 
any solutions pool inside the access tube area.

MISE EN GARDE: Rincez à fond toutes les parties qui entrent en contact avec les substances chi-
miques corrosives. Ne laissez jamais de mélanges de solutions à l'intérieur de la zone du tube d'accès.
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Cylindrical Cell Design Flushing Equipment

After washing the cylindrical cell with formic acid, follow the instructions in this section to flush the cell.

1 Place the cylindrical cell cleaning adapter (shown in Figure 10) into the calorimeter's cells (as shown in 
Figure 11. 

 Figure 10 Cylindrical cell cleaning adapter and cross-section of cleaning flow.

 Figure 11 Positioning the cylindrical cell flushing apparatus.

2 Place the inlet tubing in a large volume of water and attach the outlet tube to a vacuum pump trap flask. 
This allows you to flush large volumes of liquid through the cell.

3 If the formic acid rinse appears inadequate (as judged by noisy water/water baseline scans), follow the 
intense cleaning procedure as described later in this chapter.
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Capillary Cell Design Flushing Equipment

After washing the capillary cell with formic acid, follow the instructions in this section to flush the cell.

1 Attach the Manosil silicone tubing to the access tubes for each cell in the calorimeter.

2 Connect one side to a large flask of water, and the other side to a vacuum pump trap flask as shown in 
the figure below. This allows a large volume of solution to be drawn through the calorimeter's cells.

3 If the formic acid rinse appears inadequate, (as judged by noisy water/water baseline scans), follow the 
intense cleaning procedure as described later in this chapter.

 Figure 12 Capillary cell cleaning apparatus for flushing large volumes.
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Software
Several software programs are available for use with the Nano DSC. The table below outlines the usage for 
each one. For more details on these programs, see the online help.

Table 2: Nano DSC Analysis Software

Program Functions

DSCRun This program controls the operation of the Nano DSC and is used for 
data acquisition. 
The main components are:

• DSC control panel

• Main menu functions

• Operating modes and status

NanoAnalyze Thermodynamic analysis of experimental data is conducted in this pro-
gram. It allows you to calculate the partial molar and excess heat capac-
ities of the biopolymer. Afterwards, the data can be fit to a series of 
models that are appropriate to the system being studied.

The following features are present in this program:

• Viewing, exporting, and importing data files.

• Conversion of microwatt data into molar heat capacity. It requires a 
sample data file and a baseline data file for operation.

• The ability to fit molar heat capacity or excess heat capacity data to 
one of four models. All of the models assume that there are two-
state or multi-state transitions in the data.

Data can be exported from NanoAnalyze to Microsoft® Excel.
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Maintaining the Nano DSC
Maintaining the Nano DSC consists of performing balance runs when baseline shifts indicate a need, purg-
ing the instrument, cleaning the filter, lubricating the o-ring, and thoroughly cleaning the cells. This section 
provides information on these procedures.

Balance and Residual

NOTE: Use of the residual scan feature will not affect your data in any way.

The balance and residual scan scans serve to flatten the baselines, allowing for easier visual interpretation 
especially in real time or when collecting data for presentation. Perfect flatness is not a strict requirement; 
when baseline scans are subtracted from sample scans, the baseline shifts cancel out. Users may find it 
convenient to renew the baseline and residual scans from time to time, as the baseline shifts over time. This 
will result in water baseline data that do not fall within +100 µwatt range.

The measuring unit of your Nano DSC contains two cells that are closely matched in mass and internal 
volume. These cells are attached to the calorimeter block via the access tubes. During the manufacture of 
your calorimeter, these access tubes were machined to match the thermal conductivity of the sample and 
reference cells. Since it is impossible to achieve a perfect match of the thermal paths for the two cells, an 
instrument baseline, or balance run, is performed. This balance run creates a baseline for the calorimeter, 
which yields a heat flow signal that is near zero when both cells contain solutions with the identical heat 
capacity.

The balance run will give you a satisfactory baseline. However, to further flatten the baseline across the 
entire temperature range, you can correct the instrument baseline by running a “residual” scan. A residual 
scan is generally used for cosmetic reasons only; the real sample heat capacity data is obtained by subtract-
ing data from the baseline, not from individual scans. Use the same scan rate and temperature limits as the 
experiment.

The residual feature of this software is simply a process used to adjust the linearity of the instrument base-
line to display a value near zero.

The procedure for balancing the cells and creating residual scan data are as follows:

1 Load the cells with degassed, deionized water. Be sure you have no bubbles.

2 Select Tools > Balance Cells from the DSCRun menu bar. The calorimeter performs a 0 to 130°C scan 
(both up and down). 

3 Allow the cells to equilibrate.

4 Select Tools > Residual data base from the DSCRun menu bar (see the three figures below).

Set the attributes of the Residual data base dialog box as shown below. (Examples only. Rate and T-
lower must match the intended future experiment; T-upper must equal or exceed the experiment final 
temperature.)

• Rate: 1

• T-lower: 0

• T-upper: 130



Nano DSC Getting Started Guide Page 30

5 Remove the previous residual values by highlighting each value on the residual data panel (Label box) 
and then clicking Remove (see the figures below).

 Figure 13 Residual Baseline screen; Add Baseline dialog box.

NOTE: The items in the Label box must be removed before a new residual can be run.

NOTE: It is perfectly acceptable to run the Nano DSC with only a balance and no residual (that is, the 
residual values are zero (O) in the Label box), or a residual scan without re-balancing the instrument first.

6 Select Add (or Rescan) to begin. Again, the instrument will scan up and down from 0 to 130°C.

7 Wait for the scans to finish. Then select File > Save from the main menu to store the residual values.

Your instrument is now balanced and ready for use.

A different scan rate other than 1°C/min requires a different residual scan to achieve a flat baseline. For 
example, if your application requires a 0.5°C/min scan rate, perform a residual scan (you do not need to 
run another balance scan) as described above, but change the Rate Attribute value from 1 to 0.5. 
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Purging the Nano DSC

The Nano DSC features a sealed, nitrogen-filled canister surrounding the measurement cells in order to 
ensure stable operation. If baselines become unstable, it may be necessary to contact TA Instruments for 
service. Check for stability by monitoring the signal repeatability, especially at temperatures above 60°C. 
If the signal varies significantly with no pattern from one scan to the next, contact TA Instruments Service 
to determine if there is a need to service the instrument.

Important Note: The canister has been vacuum-purged and back-filled with dry nitrogen gas at the factory 
before shipment, and will only very rarely be required again in the field. Contact TA Instruments for 
service if the instrument does not maintain a stable signal as described above.

Cleaning O-Rings

In order to ensure a good seal for the pressure handle, you may need to occasionally remove the o-ring 
from the access flange with a pair of dull tweezers. Be very careful not to tear or puncture the o-ring or 
scratch the surface of the seating channel. Clean the o-ring groove and o-ring, then lubricate the o-ring with 
vacuum grease and reinstall it.

Cleaning the Instrument

Regular Cleaning

During normal operation it is recommended that you clean the Nano DSC sample and reference cells with 
a 50% formic acid solution between samples. Remove the sample then load the formic acid into both cells. 
Scan from 25 to 75 °C and back to 25 °C. After the cells have cooled to 25 °C, rinse each cell with 1 L of 
deionized water. See page 29 for details.

If, however, there is excessive noise in subsequent scans, or you suspect a residue or precipitate in the 
cells, follow the cleaning procedure below.

Thorough Cleaning

These procedures are used to more thoroughly clean the instrument if needed. Select the process that is 
appropriate to the suspected contaminant. Sodium hydroxide cleaning is always followed by a formic acid 
neutralization step.

All rinsing or flushing operations should be done with the cleaning devices described beginning on 
page 25. Caustic solutions should be loaded and removed with the appropriate syringe or micropipette.

Protein Deposits: Pepsin Solution

1 Prepare a solution containing 0.5 M NaCl, 0.1 M Acetic Acid and 1 mg/mL Pepsin.

2 Place this solution in the calorimeter for a minimum of three hours, preferably at 30°C. (Use fresh pepsin 
each time as it eats itself up in solution.) 

3 Flush the cells with 1 to 2 L of deionized water after the solution has been in the calorimeter for three 
hours or more.
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Mineral Deposits, Step A: NaOH Solution

1 Prepare a 4.0 M NaOH solution.

2 Place this solution in the calorimeter and run a scan from 25 to 90°C at 2°C/min. Interrupt the scan at 
90°C and let it stand at this temperature overnight. 

3 Flush the cells with 1 to 2 L of deionized water after the NaOH solution has been in the calorimeter over 
night.

Step B: Formic Acid Solution

1 Prepare a 50% formic acid solution.

2 Place the solution in the calorimeter and run a scan from 25 to 65°C at 2°C/min. Interrupt the scan at 
75°C and let it stand at this temperature for 20 minutes. 

3 Flush the cells with 1 to 2 L of deionized water after the 20 minutes have passed.

Grease or Oil

If you suspect grease or oil in the cells, follow these steps.

1 Place HPLC grade tetrahydrofuran in the calorimeter and run a scan from 25 to 50°C at 2°C/min. 

2 Interrupt the scan at 50°C and let it stand at this temperature for 20 min.

Soapy Water Flush

1 Exit from the DSCRun software. (This must be done whenever you pass large volumes of solutions 
through the Nano DSC.)

2 Flush or aspirate 100 mL of soapy water (for example, SDS) through the cells.

Final Flush

Flush or aspirate 1 to 2L of deionized water through each cell.
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Troubleshooting the Instrument
The following table provides tips on how to solve various problems that you may encounter when using 
the Nano DSC. For anything not solved below, please call TA Instruments for service.

Table 3: Common Troubleshooting

Symptoms Possible Problem Action/Remedy

Random sharp spikes 
in scan traces.

• Air bubbles in sample.

• Air bubbles in Nano DSC.

• Degas sample.

• Fill cells correctly so no air pockets develop.

Noisy scans. • Contamination from previous 
sample.

• Precipitation of sample.

• Sample contamination.

• Canister may need to be 
evacuated.

• Clean cells thoroughly.

• Clean cells with 4 M NaOH solution. Rinse 
thoroughly. Avoid running a sample that 
precipitates or is a suspension.

• Check sample for impurities. Check syringe 
and needle for contaminants.

• This service is rarely needed. Consult with TA 
Instruments representative before proceeding.

Scans have a sharp 
jagged rise between 
90 and 100°C.

Sample is boiling out of cells. Cells may not be pressurized. Check for possible 
causes: 
• Pressure handle not installed

•  Manostat not adjusted to elevated pressure

• Missing, torn, or contaminated pressure han-
dle o-ring

Only the last scan is 
displayed during the 
run.

View option setting. Select All scans under the View option on the 
toolbar.

Water-water scans do 
not fall within the 
+100 µW range.

• Balance has degraded over 
time.

• The cells are unevenly filled.

• Rebalance the Nano DSC. Run a residual.

• Refill the Nano DSC carefully with the same 
amount of solution in each cell.

Consecutive base-
lines shift by more 
than 3 µW.

• Cells require cleaning cure.

• Canister may need to be 
evacuated.

• Pressure leak.

• Select and perform appropriate cleaning 
procedure.

• This service is rarely needed. Consult with TA 
Instruments representative before proceeding.

• Check the pressure handle and o-ring.

Nano DSC does not 
hold constant pres-
sure.

• O-ring is dry, contaminated, or 
damaged.

• Pressure handle is not screwed 
on tightly.

• Carefully remove the o-ring (do not use sharp 
metal tools). Inspect, wipe clean, and lubri-
cate the access o-ring. Replace if necessary.

• Tighten the pressure handle.
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Nano DSC does not 
pressurize

• No power to instrument 
(Green light on front panel 
should be illuminated)

• Pressure motor piston not in 
initial position

• Check power cord, surge suppressor strip, and 
electrical service.

• Remove pressure handle and reset by clicking 
on depressurize control (“down” arrow)

Table 3: Common Troubleshooting (Continued)

Symptoms Possible Problem Action/Remedy
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Appendix: A
Pressure Perturbation Experiments

Colette Quinn, Ph.D. and Lee Hansen, Ph.D.
TA Instruments, 890 West 410 North, Lindon, UT 84042, USA

Introduction
Pressure Perturbation Calorimetry (PPC) is a technique for determination of thermal and volumetric prop-
erties of macromolecules. These properties include the partial molar thermal cubic expansion coefficient 
( , Equation 1, [1]) and the relative partial molar volume ( , Equation 2, [2]) of the macromolecule 
as functions of temperature. These parameters are associated with hydration of the macromolecule [3, 4].  
The method consists of measuring the heat effect, Q, from applying a pressure change, p, to a solution 
of the macromolecule.  and  are then calculated by the following equations.

The Nano DSC is currently equipped with the necessary components to perform PPC without further mod-
ification. PPC is typically performed on a DSC that is capable of increasing and decreasing the pressure on 
a sample during a DSC temperature scan or during isothermal measurements. During a temperature scan, 
the pressure change must occur faster than the heating or cooling of the system (3, 4). This note is a short 
tutorial on the required steps to set-up an experiment on the Nano DSC with DSCRun software and then on 
analysis of the resulting PPC data with NanoAnalyze software to evaluate , which denoted as TEC in the 
software.

PPC with DSCRun
Turn on the Nano DSC, then open DSCRun and allow the system to stabilize. In the DSCRun software 
open set runtime variable under the Tools menu. 

On the Experimental Method tab, check either scanning or isothermal and enter the temperature limits 
and scan rate; see Figure 14. If scanning, a slow rate is required because the calculations assume isothermal 
conditions; see the definition of  in Equation 1 (4). If the scan rate is slower than the instrument feedback 
then it can be safely assumed isothermal during the pressure steps. A rate of 0.1 ºC/min is recommended. 
This scan rate will typically satisfy the isothermal requirement without scanning so slowly that resolution 
of the heat rate is unduly sacrificed.
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Choose the pressure function to be applied during the experiment. See Figure 14.

 Figure 14 Screen shot of DSCRun highlighting the different pressure parameters available.

Three different pressure control options are available: linear, sine, or ramp (labeled jump in the software). 
The jump pressure function is usually used. Once the desired pressure function is selected and all Temper-
ature Parameters are set for the scan, click Add To Experiment Method. This opens a dialog box that 
enables setting the Jump Pressure Function (see Figure 15). 

 Figure 15 Screen shot of dialog box that opens after a pressure function has been selected. (A indicates 
atmospheres and s indicates seconds.)

Note that in scanning experiments, pressure can be designated as a function of time or temperature. The 
term "step" in this box refers to the pressure step. Although the instrument is capable of operating from 0 to 
6 atm, relative to ambient pressure, the recommended pressure change is from 1 to 5 atm with a ramp/step 
time of 600 s (4). The minimum pressure must exceed a pressure that allows boiling at any temperature 
during the scan. For most experiments, the default motor speed of 28 x 10-1 ms/step is sufficiently slow to 
satisfy the requirement of isobaric conditions in Equation 1.
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Experimental Set-up
A water-water scan can serve as a test experiment to assess any asymmetry between the reference and sam-
ple cells. For this test, water is loaded into both the reference and sample cell. The pressure is stepped from 
1 to 5 atm, starting at low pressure with time steps of 600 s while scanning at 0.1 ºC/min from 20 to 80 ºC. 
During the experiment pressure is applied equally to both sample and reference cells, so any deviation of 
Q from zero is solely due to any asymmetry between the cells.

For typical solutions of macromolecules, a concentration of 10 mg/mL should generate good data. Due to 
the slow scan rate, concentration requirements for PPC experiments are greater than for a normal DSC 
scan. The PPC experiment consists of two parts, a background run and a sample run. Background data with 
buffer in both reference and sample cells should be collected under identical PPC conditions as the sample. 
Sample data must be collected with the same buffer in the sample cell. The basis for this method and the 
calculations done in NanoAnalyze are as follows (Equations 3-5).

measured is calculated from the data with sample solution in the sample cell and buffer in the reference cell 
and asymmetry is calculated from the data with buffer in both cells.

PPC Fitting with NanoAnalyze
The data files from the background PPC run and the sample PPC run can be opened in NanoAnlayze with-
out modification. When the raw data files are initially opened, a dialogue box will open with a prompt: 
Analyze pressure data for Experiment Step 1? (Figure 16). In this context, "step" indicates a tempera-
ture scan or isothermal run. This request will be made for each temperature scan or isothermal run if the 
box at the bottom is not checked.  

 Figure 16 Dialogue box prompt when opening PPC data with NanoAnalyze.
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When the files are opened, extra data analysis tabs are automatically made accessible (Figure 17).  

 Figure 17 Screen shot highlighting the extra tabs accessible after opening PPC data on NanoAnalyze. 

In the Input Data tab, several key values must be entered for TEC calculations, i.e., sample cell volume, 
concentration, and molecular weight in kilodaltons. The data file is loaded with the Add file icon. The 
background data is dragged and dropped into the drop baseline here box (Figure 17). MHC (molar heat 
capacity), the second tab, is not used in PPC calculations. The third tab from the left, Integration Base-
line, gives the integrated area under each pressure events. The baseline for integration of the heat effects 
(Q) from the pressure changes can be either a straight-line (default) or a sigmoid (check Sigmoid Base-
line box) (Figure 18).  

 Figure 18 PPC sample and background data in the Integration Baseline window.
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In the Area graphs tab (Figure 19), background and sample areas are plotted. The baseline area data can 
be fit to a polynomial, labeled blank fit order in the software (as is the case with TEC Baseline and TEC 
tabs).  

 Figure 19 Area graphs window for a sample. 

The TEC Baseline is used for calculating  for pure liquids, and is not used for calculation of  for sol-
utes.

The TEC tab plots the thermal expansion coefficients in the top window (Figure 7) and the integrated area 
in the bottom window. This integrated area is the relative change in volume ( ), according to the rela-
tionship of Equation 2 (3).

 Figure 20 The TEC ( ) for a sample.

Numerical values for all of the thermal expansion data are displayed in the Table tab and can be copied to 
a clipboard and imported to another program if further manipulation is desired.
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Appendix: B
Guardian Option

Guardian Option
The Notifications tab is where Guardian option features reside. Guardian is an implementation of 21 CFR 
Part 11 regulations. Detailed information about Guardian is available in the document “Guardian for 
Microcalorimetry Software.”

 Figure 21 Guardian tab.
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